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Thank You !! for purchasing your new Software Control Application from PESA. We appreciate 
your confidence in our products. PESA produces quality, state-of-the-art equipment designed to 
deliver our users the highest degree of performance, dependability and versatility available anywhere. 
We want you to know that if you ever have a concern or problem with a PESA product, we have a 
team of engineers, technicians and customer service professionals available 24/7/365 to help resolve 
the issue.  
 
Our commitment is to continue earning the trust and confidence of our customers throughout the 
industry by incorporating cutting-edge technology into the highest quality, most cost effective products 
on the market. And we would like to invite you to tell us how we’re doing. If you have any comments 
or suggestions concerning your PESA equipment, please contact our Customer Service Department. 
 
Again thank you for choosing a PESA product and we look forward to a long-term partnership with 
you and your facility. 
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Chapter 1 About This Manual 
 

1.1 DOCUMENTATION AND SAFETY OVERVIEW  

This manual provides instructions for installation and operation of the Cattrax System Control 
Application for the Windows® operating system, designed and produced by PESA. 

It is the responsibility of all personnel involved in the installation, operation, and maintenance of the 
equipment to know all the applicable safety regulations for the areas in which they will be working. 
Under no circumstances should any person perform any procedure or sequence in this manual if the 
procedural sequence will directly conflict with local Safety Practices. Local Safety Practices shall 
remain as the sole determining factor for performing any procedure or sequence outlined in this 
document. 

1.2 CAUTIONS AND NOTES 

Cautions and Notes are addendum statements used in this guide that supply necessary information 
pertaining to the text or topic they address. Caution statements typically notify you of steps or 
procedures that could impede installation or operation; and/or cause damage to the equipment. Notes are 
additional statements that typically provide added information that can simplify and/or enhance the use 
or operating characteristics of the equipment. Examples of the graphic symbol used to identify each type 
of statement and the nature of the statement content are shown below: 
 
 

 

Caution statements identify conditions or practices that can result in 
personal injury and/or damage to equipment if the instructions contained in 
the statement are not complied with. 

 
 

 

Notes are for information purposes only. However, they may contain 
invaluable information important to the correct installation, operation, 
and/or maintenance of the equipment. 
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Chapter 2 Introduction 
 

2.1 DESCRIPTION  

PESA’s Cattrax is a software application, for use on a compatible host PC running the Microsoft 
Windows® XP, Windows 7, Windows 8.1 or Windows 10 operating system, to monitor and control a 
variety of PESA products. It allows users to configure, retrieve real-time information and monitor the 
operational status of controlled devices such as QFX Series modules (Vidblox, Quadbox), PESA 
routers, control panels and processing frames within the facility network.     

Cattrax communicates with managed devices over an Ethernet network through the host PC and can 
also communicate with compatible PESA devices, one at a time, using a USB port of the host PC.  
Network and USB connectivity may be used simultaneously.   

The versatile Cattrax software application greatly enhances system integration possibilities for any 
PESA installation.  Virtually any PC within your local area network (LAN) becomes a feature rich 
control panel for your PESA devices.  Users familiar with menu-driven and graphical user interface 
(GUI) based software control applications will feel right at home with Cattrax.  Figure 2-1 illustrates a 
typical screen layout of the Cattrax application.  We have used a PESA Vidblox device for example 
illustrations throughout this User Guide. 

2.2 CATTRAX DOCUMENTATION  

A wide variety of PESA products may be controlled through menus and display pages of the Cattrax 
application. Each product controlled by Cattrax, such as Vidblox, Quadbox, PERC System Controllers, 
etc. requires a unique set of operating controls and displays within the Cattrax platform for 
implementation of its specific configuration, control or monitoring requirements.  

Due to the extreme diversity of the software application and specific requirements for each controlled 
device, a single User Guide covering all operations of the Cattrax product would not be practical, or 
user-friendly. For this reason, the Cattrax documentation suite consists of a generic User Guide (this 
document) that provides an introduction to Cattrax, procedures to install the application on a Windows 
based PC, and instructions pertinent to set-up and operation of the Cattrax software application.  

This User Guide DOES NOT contain configuration, control or monitoring procedures for any of the 
PESA products or devices that can be controlled using the Cattrax application. Device-specific 
procedures for using Cattrax to control any compatible PESA product may be found in the User Guide 
or Technical Manual for the device or product.  

A complete documentation suite for Cattrax would then consist of the latest revision of this User Guide 
and the User Guides for all PESA products or devices you are controlling with Cattrax.      
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Figure 2-1  Cattrax Screen Layout 
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2.3 CATTRAX CONTROLLER FEATURES 

• Automatic Device Discovery and Display - Automatically “discovers” PESA devices and 
control panels operating over the facility’s internal network or connected through a USB port of 
the host PC and displays located devices in a hierarchical tree structure to provide a global view 
of the system.  The entry for a device “discovered” through the USB port is displayed in the 
device tree with a USB icon overlay to differentiate it from network devices. 

• Alarm Monitoring  – Monitors alarms and events from the discovered devices, and displays 
them in a table format. Table columns may be sorted to make search and diagnosis of reported 
alarms and events faster and more convenient.   

• Menu Driven Configuration and Control  – Uses a standard Windows® operating system tree 
structure for quick access to menus. Current configuration of multiple devices may be displayed 
simultaneously, reconfigured and controlled in real-time to optimize device functions.  

• Configuration Management – Helps users manage the configuration of their system more 
quickly and effectively. It allows configuration of individual devices; or the entire system 
configuration may be saved to a file, and then restored by the user when needed. Cattrax also 
supports automatic device configuration restoration. 

• Remote Access over VPN – Network parameters can be configured to allow use of Cattrax 
over a VPN link. 

• Automated Batch Firmware Update – Allows you to update software or firmware code on 
multiple PESA devices of the same type simultaneously. 

 

2.4 DOCKABLE WINDOW PANELS 

Various window panels displayed by Cattrax, such as Alarms & Events, Menu Tree, etc, are dockable, 
and may be moved and re-docked to any position preferred by the user. As an example, Figure 2-2, 
shows the Alarms & Events panel moved to the top part of the screen from the bottom, and the Menu 
Tree moved from the left side to the right.  Any time the software is closed, Cattrax saves the current 
screen layout and displays the same layout when restarted.  

Screen position of the Menu Tree selection is global across all devices. For example, if the menu tree is 
moved from left to right for the device named “Vidblox Rx One,” as shown in Figure 2-2, all new cards 
or devices opened after the change will display their menu tree on the right.  

You may restore the screen layout to the default appearance at any time by clicking on the Default 
Layout selection in the View menu.  
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Figure 2-2  Cattrax with Reconfigured Window Positions 
 

 

2.5 HARDWARE SYSTEM REQUIREMENTS  

Cattrax requires a PC running the Microsoft Windows® XP, Windows 7, Windows 8.1 or Windows 10 
operating system, with a minimum of 512 MB RAM.  The entire application requires approximately 60 
MB of disk space on a local drive.  
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Chapter 3 Installation 
 

3.1 CATTRAX INSTALLATION  

Cattrax is a graphical user interface (GUI) type software application for use on a standard PC running the 
Microsoft Windows® XP, Windows 7, Windows 8.1 or Windows 10 operating system. The PC must have a 
CD-ROM drive for installation of Cattrax and, in order to connect with PESA devices communicating over 
the facility network, must have wired or wireless access to the local area network (LAN).  A mouse with 
scroll-wheel is recommended for precise control of device parameter values using slider controls, and a 
monitor size of 19 inches or larger is also recommended.   

3.2 INSTALL CATTRAX PROGRAM AND DATA FILES (WINDOWS XP AND WINDOWS 7 SYSTEMS) 

Your Cattrax installation disk contains an auto-run file that guides you through the installation process.  
Examples of the pop-up screens you will see are shown below with the appropriate step.  Notice the “X” 
used in place of actual values on each example screen presented here.  During installation the release 
number of Cattrax software you are installing is displayed.   

Install the Cattrax software application as follows: 

1. Insert Cattrax CD into CD Drive of host PC.   

2. Allow the disk to initiate the auto-run function.  
When initialization is complete, the banner, as 
shown at right, is displayed on the desktop.  Click 
Next to begin installation of the Cattrax application.   

3. If the auto-run function does not automatically 
launch, navigate to the directory of the disk drive 
containing the installation CD and double click the 
Cattrax.exe file.  The banner shown at right should 
be displayed on the desktop.  Click Next to begin 
installation. 

 

4. Read the license agreement and click I Agree to 
continue, as shown at left.  

 

 

 

 

  

5. The Choose Components window allows you to 
select the software components you wish to install.  
During initial installation, the only option is to 
install the entire program.  Ensure that the box next 
to “Cattrax” in the list box is checked. 
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6. If you want to install the USB port driver, also check the “PESA QFX Driver” box  

7. Click Next to continue installation. 

 

 

8. By default auto-install creates the folder shown 
at left for the Cattrax application.  If you wish to 
install the software in a directory or folder other 
than the default, click Browse and navigate to 
the destination.  Click Install  to continue 
installation.   

 

 

 
 
 
9. Once Cattrax is installed, you will receive the 

prompt to install the QFX USB driver.  Click 
“OK” to install the driver.  If the QFX USB 
driver is not present on the host PC, Cattrax 
will not be able to communicate with a 
connected device through the USB port. 

 

 

 

10. You may accept the default installation 
location, as shown at left, or browse to 
another folder in which you wish to install 
the QFX USB driver.  When the destination 
folder is correct, click the Install button to 
proceed with driver installation. 

 

 

 

 

11. You may receive a message indicating that the 
software has not passed Windows Logo testing, 
as shown at right.  The USB driver files have 
been thoroughly validated.  Click “Continue 
Anyway” to continue. 
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12. You will see the screen at left as installation 
continues. 

 
 
 
 
 
 
 

 
 

13. When driver installation is complete, you 
will receive a prompt indicating that the 
installation was successful, as shown at 
right.  Click “OK” to continue to the 
“Installation Complete” prompt.     

 
 

14. Click Finish to exit the installation process.  
During installation a shortcut icon to launch 
Cattrax is automatically placed on the desktop.  If 
the box next to “Run Cattrax Release X.X” is 
checked, the application will start immediately.   

 

 

 

 

 

3.3 INSTALL CATTRAX PROGRAM AND DATA FILES (WINDOWS 8.1 AND WINDOWS 10 SYSTEMS) 

The Cattrax application will install directly from the installation CD on Windows 8.1 and Windows 10 
machines, however, the QFX driver that allows USB connection to a single, compatible PESA product will 
not. If you do not intend to use the USB port for control interface with a PESA device, it is not necessary 
that you install the QFX driver. The Cattrax application will discover and control devices on the facility 
network without the driver installed. 

If you need to install the QFX driver to allow USB communication with Cattrax through Windows 8.1 or 
Windows 10, the following procedure must be performed before attempting to load the driver from the 
Cattrax installation disk. The following steps assume that this is an initial install and Cattrax is not currently 
loaded onto the host PC. However, if Cattrax is loaded and you simply want to add the QFX driver, it is not 
necessary to uninstall Cattrax prior to adding the QFX driver.  
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Install the PESA QFX driver as follows, with the exception of 3 and 4, the procedural steps are identical for 
either Windows 8.1 or Windows 10: 

1.  Click the Windows icon in the lower left corner of the Task bar 

2.  Select "Settings"  

3.  Click on "Change PC settings” (Windows 8.1 only), proceed to Step 4 (Windows 10)  

4.  Select "Update and Recovery" on Windows 8.1 machines, or “Update and Security” on Windows 10 
machines 

5.  Select “Recovery”  

6.  Click "Restart Now" 

7.  When system restarts select "Troubleshoot" 

8.  Select "Advanced options" 

9.  Select "Startup Settings" 

10.  Click on "Restart". System will now reboot 

11.  Press 7 Disable driver signature enforcement 

12.  Login 

13.  Run the Cattrax setup program, refer to Paragraph 3.2 

14.  At the "Choose components" screen select both “Cattrax” and "PESA QFX Driver" for a full install, 
or check only the QFX driver option if Cattrax is already installed on the PC. 

15.  Take defaults at all prompts 

16.  At the Windows security prompt select "Install this driver software anyway" 

17.  Upon Cattrax setup completion uncheck "Run Cattrax x.x" and "Show Release Notes" and press 
Finish 

18.  Reboot machine and run as normal after restart. 

 

 

3.4 REMOVING CATTRAX INSTALLATION  

Should it ever be necessary to remove Cattrax from the 
PC, the uninstall command is available through the Start 
menu of the Windows® operating system.  A prompt 
window as shown at right is displayed on the desktop.  
Click Uninstall to complete the command.  
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3.5 CONNECT PESA DEVICE TO HOST PC THROUGH USB PORT 

If you wish to control a PESA device over a USB connection using Cattrax, perform the following steps to 
allow “Plug and Play” capability of the Windows® operating system to interface device hardware to host 
PC.   Typical USB connection is shown in Figure 3-1 using a Vidblox module as an example. 

  

 

1. Apply power to the device. 

2. Connect the USB cable first to the device and 
then into an open USB port on the host PC, as 
shown by the illustration to the left. 

3. After a brief pop-up from the taskbar, the 
“Found New Hardware” window, as shown 
below, may appear on the monitor.   

 
 
 
 
 
 

Figure 3-1  Connecting Vidblox Module to Host PC 
 
 

 
 
 
 

 
4. Select the “No, not this time” option button and then 

click Next to continue. 

 

 

 

 

5. The Driver Installation screen, as shown to the 
left, prompts you for your choice of how to 
locate and install the hardware driver. 

6. Select the first option, “Install the software 
automatically (recommended),” and click on the 
“next” button to continue. 

 
 
 

 

This window only appears if this 
is the first power-up after USB 
driver installation  

Host PC Running 
Cattrax Application 
with QFX Device 
Driver Installed

POWER
SUPPLY
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7. You will receive a message indicating that the 

software has not passed Windows Logo testing, 
as shown to the right.  The USB driver files 
have been thoroughly validated.  Click 
“Continue Anyway” to continue. 

 

 

 

 

 

 

 

 

8. During driver software installation, the 
prompt screen shown to the left is displayed.  
The progress bar monitors the installation 
procedure.    

 

 

 

 

 

 

 

 

9. When hardware installation is complete, the 
completion screen, as shown to the right is 
displayed.  Click the “Finish” button to exit the 
hardware installation wizard.   

10. The Vidblox module should now be 
communicating with the host PC. 
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3.6 CONNECTING HOST PC TO MANAGED DEVICE USING DIRECT ETHERNET CONNECTION   

Communication between the host PC running Cattrax and an external managed device is conducted over an 
Ethernet link.  This link may be established directly between the host PC and a PESA device, such as a 
Vidblox module as shown in Figure 3-2; or each component of the managed system may communicate over 
the facility network.   

It is permissible to run Cattrax from a PC already installed on the facility network; or it may be desirable, in 
certain installations, to have the host PC dedicated only to running Cattrax.  When using a dedicated PC as a 
single control element, and a single controlled device, use a crossover CAT5E interconnecting cable, 
configured as shown in Figure 3-2.  This illustration shows the rear panel of a Vidblox module as an 
example.   

 

 

Figure 3-2  Direct Connection of Host PC to Managed Device   
 

 

3.7 NETWORKED HOST PC AND CHASSIS FRAME  

When multiple PESA devices are used together, an Ethernet switch is required and used with standard 
Ethernet patch cables.  When using a switch, a crossover cable should not be used.  Connect a port on the 
Ethernet switch to an Ethernet port on the host PC using an Ethernet patch cable.  Connect a port on the 
Ethernet switch to the Ethernet port on each managed device in the system using an Ethernet patch cable.  
An example of a networked system with two host PCs is shown in Figure 3-3.  
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Cattrax
Host PC Devices

Vidblox TX Module
CAT5E Cable 
(No Crossover)

Ethernet Switch
(User Supplied)

CAT5E Cable (No Crossover)
Facility
Network

Connection 
(LAN)

QuadBox TX Module

QuadBox RX Module

 

Figure 3-3  Connecting Multiple Host PCs and PESA Devices to a Local Area Network   
 

Every host PC running Cattrax and every managed device must be assigned a unique network IP address.  In 
many installations, you will need to consult your facility network administrator when adding hardware to 
the network or when the default IP address for any hardware must be changed. 
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Chapter 4 Operation 
 

4.1  INTRODUCTION  

With Cattrax running, the host PC appears as a component of PESA control hardware.  As with many PESA 
devices, Cattrax communicates over a dedicated Ethernet link, or the facility LAN. 

The first step in preparing Cattrax for operation is to configure all system components to communicate over 
the Ethernet network.  This requires assigning and, if necessary, changing the IP address of system 
components.  

When any Ethernet devices are connected to a network using an IP protocol, each device must have a 
unique IP address assigned.  If your installation requires including PESA hardware devices into an existing 
facility LAN, you will need to consult your network administrator for the proper IP address to use for each 
device in the system.   

4.2 NETWORK CONFIGURATION  

In order for Cattrax to communicate with PESA equipment, the network interface device used by Cattrax 
must be actively connected to the subnet, or multiple subnets, containing equipment you wish to control.  
Figure 4-1 illustrates a typical single subnet network installation with the PC running Cattrax connected to 
an existing switch that connects control panels and devices. 

 

 

 

Figure 4-1  Cattrax Installation with Devices on Same Subnet 
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When communicating on a subnet containing PESA network controllable devices, Cattrax should 
immediately begin the discovery process of all devices configured for the same subnet.  In some 
installations, PESA devices may reside on subnets different from one another within the network. Cattrax 
allows you to easily select both the network interface device it uses and the subnets on which it 
communicates. To view or modify current network communication parameters for Cattrax, click the 
Network Settings icon under the Setting menu in the Cattrax menu bar to open the Network Settings 
configuration menu as shown by Figure 4-2. 

 

 
 

Figure 4-2  Network Settings Menu  
 

 
The center area displays the network interface devices available to Cattrax by IP address and name. In many 
installations there will be only one entry in the window and by default this would be the device used by 
Cattrax.  If there are multiple entries, as would be the case, for example, if the host PC contains both an 
Ethernet NIC and a wireless adapter, the device Cattrax is currently communicating through is shown 
highlighted.  You may select the network interface device you wish Cattrax to use by double-clicking the 
entry in the listing.  If you would like Cattrax to communicate over all of the listed network interface 
devices, place a checkmark in the box above the list. This option is only active if more than one device is 
listed. Be sure that the network interface device you select is communicating over the subnet(s) containing 
all PESA devices you wish to control.   
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Subnets currently available to Cattrax are listed in the lower area of the dialog box under the Subnet 
Broadcast Addresses column, Figure 4-2.  A check in the box beside an entry indicates that Cattrax is 
actively communicating over that subnet and will automatically discover PESA devices on the subnet.   If 
you wish to prevent Cattrax from communicating over a specific subnet, click the checkbox to remove the 
check.  If you need to add additional subnets or modify address parameters of currently available subnets 
use the buttons beneath the display window as follows: 

• Add – allows you to add subnets to the list of those available.  Clicking the Add button opens the 
screen shown here. 

 

 
 

Enter the IP Address and Subnet Mask parameters for the subnet address you wish to add; or use the 
pre-calculated subnet broadcast address.  You may use the text box at the bottom of the pop-up to 
enter a description of the subnet. Click OK  to enter the settings.  The new entry is added to the 
listing and the checkbox will be checked to activate the new subnet. 

• Edit  – allows you to modify address parameters of any entry in the listing.  Highlight the entry you 
wish to modify and click the Edit button.  The Subnet menu is displayed with current parameters for 
the entry listed.  Make any changes you wish and enter OK to commit the changes.   

• Remove – allows you to remove any subnet from the listing.  Highlight the entry you wish to delete 
and click the Remove button.  The entry is immediately removed from the listing. 

When you have the network parameters properly configured, click the OK  button to select the new 
configuration and exit the dialog box, or click Cancel to exit the box without making changes.  

4.3 ENHANCED DEVICE DISCOVERY OPTIONS 

PESA network controllable devices incorporate one of two proprietary application layer protocols for 
communication with Cattrax over a network, these are called QIP and P2. 

QIP protocol is used by devices in the PESA QFX family, such as Quadbox and Vidblox products; P2 is 
used by some system controller applications, such as PERC1500 and the R3232 internal controller.  
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When any PESA network compatible device is present on the same LAN subnet as the host PC running 
Cattrax, the device is discovered and listed in the Devices View tree. When devices are present on the LAN 
but configured with a different subnet than the host PC, it is necessary to select one or more of the Enhanced 
Device Discovery options to locate and discover these devices. 

Four checkboxes in the upper area of the Network Settings dialog box enable or disable the Enhanced 
Device Discovery modes. To view or modify status of currently selected enhanced discovery options, click 
the Network Settings icon under the Setting menu in the Cattrax menu bar to open the Network Settings 
configuration page as shown by Figure 4-2. 

Each enhanced discovery option is discussed in the following paragraphs. 

4.3.1 ENABLE MULTICAST QIP DEVICE DISCOVERY  

PESA QIP protocol devices connect to Cattrax using the UDP network protocol.  

To reduce network traffic, Cattrax does not normally look outside of its own subnet for PESA devices. 
When the Enable multicast QIP device discovery option is selected, Cattrax issues a UDP multicast message 
over the LAN and lists any QIP devices that respond as an inactive (gray) entry in the Devices View tree.  

In order for Cattrax to control the discovered device, its current IP network parameters must be changed to 
allow it to communicate on the same subnet as the host PC. This may be done directly from Cattrax as 
follows: 

• Ensure that the Device Display Selector is set to All, see Paragraph 4.8. 

• Double click the grayed entry of the device in the Devices View tree.  

• Current network communication parameters are listed in the Device Properties box. 

• Change the network parameters of the device to values that allow it to communicate on the same subnet 
as the host PC. Click in the cell for the value you wish to change, enter the new value, and click the 
Apply button. 

• Cattrax will communicate the new address data to the device using UDP multicast and initiate the 
address change. 

• Once the device is communicating with Cattrax on the same subnet, the Devices View tree entry 
becomes active (bold) and may be selected for Cattrax control. 

You may select this option to search for QIP devices at any time. Once devices are found and listed, it is not 
necessary to keep the option active. 

In order to reduce network traffic, if you are not running multiple subnets, or know that there are no devices 
on another subnet you wish to discover with Cattrax, this option should not be selected. 

A check in the box indicates the multicast QIP discovery option is enabled. Click in the box to remove the 
check, and disable this discovery option. 

4.3.2 ENHANCED P2 DEVICE DISCOVERY  

PESA P2 protocol devices connect to Cattrax using the TCP network protocol. TCP communication 
requires that devices be on the same or an overlapping subnet for communication. There are two options for 
discovering P2 devices located on a different subnet from the Cattrax host PC. The current network address 
of the P2 device determines which of the enhanced discovery options is required to locate it and establish 
communication with Cattrax. 
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4.3.3 ENABLE MULTICAST P2 DEVICE DISCOVERY  

This discovery option locates multicast compatible P2 devices that are not on the same subnet or an 
overlapping subnet. When the Enable multicast P2 device discovery option is enabled, Cattrax issues a UDP 
multicast message requesting all P2 devices on the LAN that are compatible with P2 multicast to respond 
with their current IP address. Firmware in multicast compatible P2 devices allow them to receive and 
respond to this UDP message from Cattrax, even though there can be no control communication established 
between devices using the UDP protocol.  

When Cattrax receives a UDP response from a P2 device, it notifies the user using a pop-up dialog box that 
a P2 device has been located, but in order to control the device, its IP address must be changed to be on the 
same subnet as the Cattrax host PC.   

From the pop-up box, the user may enter a new, compatible IP address for the P2 device. This new address 
is sent to that device over UDP and the device changes its IP address to the new address. Once the address 
change is effective, Cattrax will discover the device by TCP protocol and list it as a controllable device in 
the Devices View tree. 

This option is particularly useful to search for new P2 devices, or for devices whose currently set IP address 
is unknown, that have been installed on the network but do not appear in the Cattrax Devices View tree. 
Once the network address of the P2 device has been changed, and the device discovered, it is not necessary 
to keep the multicast P2 discovery option enabled.  

4.3.4 ENABLE BROADCAST P2 DEVICE DISCOVERY  

The second P2 discovery option locates devices that are in overlapping subnets, such that TCP 
communication is still possible, but Cattrax will not directly discover the device through its discovery 
process. This can occur if the subnet mask of the device does not allow it to receive a discovery broadcast 
message from Cattrax, but its IP address is in the range of addresses for the subnet configured for Cattrax. 

To reduce network traffic, Cattrax does not normally issue a network wide broadcast message looking for 
PESA devices. When the Enable broadcast P2 device discovery option is selected, Cattrax issues a TCP 
broadcast message over the LAN and connects to any P2 devices that respond with an IP address that falls 
within Cattrax’ subnet. Discovered P2 devices are listed in the Device View tree and can be selected for 
Cattrax control just as any other device in the listing.  

You may select this option to search for P2 devices at any time. Once a device is found, it is not necessary 
to keep the option active to retain communication with the device. 

In order to reduce network traffic, if you are not running multiple subnets, or know that there are no devices 
on an overlapping subnet you wish to discover with Cattrax, this option should not be selected. 

A check in the box indicates the broadcast P2 discovery option is enabled. Click in the box to remove the 
check, and disable this discovery option. 

When you have enabled or disabled the enhanced discovery options as desired, click the OK  button to 
accept the new selections and exit the dialog box, or click Cancel to exit the box without making changes.  

4.3.5 ENABLE SLP DEVICE DISCOVERY  

The SLP device discovery option locates openGear devices and other SLP compatible devices. This box 
must be checked in order for Cattrax to discover and establish communication with PESA’s openGear 
compatible devices such as the C22-OG, Vidblox HTR-OG, an openGear frame internal frame controller, or 
the Cobalt openGear or stand-alone multiviewer devices. 
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4.4 GET ACQUAINTED WITH CATTRAX  

Double click on the desktop shortcut icon to start the Cattrax application. 

A typical screen display of Cattrax is shown in Figure 4-3.  Note that the display is composed of a number 
of individual “panels” each of which displays various menus or operational data. Figure 4-3 illustrates a 
typical display set-up; however, Cattrax provides tools that allow you to customize the display to individual 
preferences.  For this reason your display may not appear exactly as the example screen shown here.  
However, the function of each display panel is the same regardless of screen placement.  Each display panel 
is briefly introduced in the following text.  

 

 

Figure 4-3  Cattrax Panel Layout   
 
DEVICES VIEW PANEL  
 
The Devices View panel contains a display of PESA devices “discovered” on the network, or any single 
device connected through the USB port of the host PC.  Devices are grouped by device type, and may be 
sorted by IP address, device name, or both.  The entry for a device connected through the USB port is 
displayed in the tree with a USB icon overlay to differentiate it from network devices.  This listing is also 
used to select the device to be controlled by Cattrax. 
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MENU TREE PANEL  

Menu Tree displays a listing of menus and sub-menus for the device selected from the Devices View panel.  
Tree branching is controlled by clicking on boxes containing plus and minus signs in the listing, exactly as 
in a typical Windows® operating system based application. 

MAIN DISPLAY PANEL  

Operational characteristics, configuration, or controls for the menu item selected in the Menu Tree listing 
are displayed in the Main Display panel.  Control and display functions used in this panel follow standard 
Windows® operating system protocol. 

DEVICE TABS  

When a device from the Devices View panel is selected (by double clicking entry in device listing), a 
Device Tab is automatically displayed for it above the main display panel area.  When a tab is displayed for 
a particular device, you may immediately select the device by simply clicking on the tab.  The Menu Tree 
display changes to reflect the new device selection.  

DEVICE PROPERTIES PANEL  

Operational characteristics for the device selected in the Devices View panel are displayed in this panel.  
Properties such as IP address of the device and other data related to selected device are displayed.    

ALARMS AND EVENTS PANEL  

Cattrax monitors status of all active devices listed in the Devices View panel.  Alarm conditions and other 
event flags are displayed in real-time.  When an alarm condition occurs, a prompt identifying the condition 
appears in the listing and, if the notification function is selected, a flashing icon appears on the Devices 
View panel.    

 

4.5  BOARD DEFINITION FILES  

 

 

The information in this paragraph is provided in order to better acquaint 
you with the Cattrax application. On initial instal lation, it should not be 
necessary to make any changes or additions to board definition files, known 
as BDX files, since Cattrax is shipped from the factory with all current BDX 
files installed.  You should only have to verify presence of a BDX file if you 
receive an error message during operation stating that a configuration file is 
not present for a managed device.  If you change a managed device in the 
future, it may be necessary to install a new or updated BDX file.  If you ever 
need BDX files, they are available from PESA Customer Service. 

 

In order for Cattrax to control an external device such as a PESA router, QFX Series module, or signal 
processing card, the correct Board Definition File (BDX) for the device must be present in the BDXFiles 
folder under the Cattrax directory, as shown in Figure 4-4.  
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Figure 4-4  Directory Showing Location of BDX Files (shown on Windows 7 OS) 
 

Each BDX file name is in two parts – a brief identifier of the device name and the version number of the 
software code loaded into flash memory of the device supported by the BDX file. For example, in order to 
control a DRS DXE frame loaded with software version 1.0.0.0 requires that BDX file 
DRSDXE_1.0.0.XML be present in the BDXFiles folder.  Note that only the first three digits of the 
software version number are relevant. New BDX files are released as required to support device software 
revisions or updates, and are available from PESA Customer Service.  The BDX file directory may store 
multiple BDX files to support devices of the same type that may be running with different software 
revisions; an example of this is shown in Figure 4-4 with multiple BDX listings for DVA617 signal 
processing cards with different software versions. Cattrax will automatically locate and use the correct BDX 
file for the selected device. 

All PESA BDX files end with the .XML extension. 

 

4.6 INITIALIZATION  

When Cattrax is started, the software executes a discovery process as part of initialization to locate PESA 
devices on the network, or any single PESA device attached to the USB port, available for control.  When 
the process is complete, discovered frames, devices and cards are displayed as a tree listing in the Devices 
View panel. You can expand the tree nodes to show all frames and panels discovered by Cattrax, as shown 
by Figure 4-5. 

 

 

PESA Remote Control Panels, such as the RCP503, must have the correct 
software version installed in order to be discovered by Cattrax. 
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Figure 4-5  Example of Device Tree on Initial Startup. 
 

 

The device tree shows both active and inactive devices, with active devices shown in bold. Inactive devices 
are devices that do not respond to a ping request from Cattrax after discovery. It is possible to delete 
inactive devices from the device tree using the right-click menu when the device is selected. 

If Cattrax discovers more than one device with the same IP address, it shows all devices with that address as 
inactive. You can change the IP address of devices affected from the Device Properties panel to resolve the 
conflict.  IP address conflicts are also displayed by an entry in the Alarms and Events panel.  Once a conflict 
is resolved, click the Refresh button in the Devices View menu header to rediscover the devices.  If a 
discovered device has an IP address with a network address different from Cattrax, it also shows that device 
as inactive.  

Devices with major alarms reported in the Alarms and Events panel are shown in red.  
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4.7 CHANGING DEVICE IP ADDRESS 

Cattrax allows users to change an IP address of both active and inactive devices from the Device Properties 
panel shown below in Figure 4-6. This feature is particularly useful for devices that are inactive due to an IP 
address conflict with other devices, or having a different network address.  Cattrax allows you to correctly 
set the IP address of such devices directly without having to isolate the device from the network.  

To change networking parameters for the selected device, simply enter the desired IP address, Subnet Mask 
or Gateway address in the boxes contained under the IP Address panel on the Device Properties panel and 
click Apply . 

 

 
 

Figure 4-6  Changing IP Address from Device Properties Panel 
 
 
 

 

Operation of the change IP address feature requires support from software 
in the target device. If not supported by the device, the feature is 
automatically disabled by Cattrax 

Specific PESA devices, such as Vidblox modules, may have other IP 
configuration methods in addition to using the Device Properties menu.  If 
you have such devices in your system, the alternate network configuration 
methods are presented and discussed in the User Manual for the particular 
device. 

 



Cattrax PC Based Control Application 
Publication 81-9059-0677-0, Rev. G 

March 2017 

 4-11 

 

4.8 CONTROLLING  DEVICE TREE DISPLAY  

The header area in the Devices View panel provides a number of controls related to display of devices in the 
device tree.  

Clicking an icon shown in Figure 4-7 initiates the following action: 

 
Figure 4-7  Devices View Controls 

 

• Refresh View – Restarts discovery of network devices and updates the device tree.  

• Batch Configure – Puts multiple devices of the same type in Batch Configuration mode, refer 
to Paragraph 4.16.  

• Locate Device – Locates and highlights in the Devices View listing the device currently 
selected by the active Device Tab.  

• Offline Configuration  – Allows you to create or modify configuration files for PESA system 
controller devices without Cattrax having to be attached to the device.  

• Device Display Selector - Is a drop-down menu that allows you to select whether the display 
lists only active devices, or both active and inactive devices.  

• Levels of Display Selector – Opens a drop-down menu with options for 1 Level or 2 Level 
display. When 1 level display is chosen, discovered devices are listed in the Devices View 
listing in alphanumeric order under each equipment category header. Selecting 2 Level display 
adds a second header under each equipment category header to further sort discovered devices 
by equipment type within a specific category.   

• Display Style Selector – Is a drop-down menu that allows you to select how devices are 
displayed in the device tree - by their name, by their IP address, both name and IP address or by 
device type. Selection of the same option, for example By IP, changes the display order from 
ascending to descending or vice-versa. 

• Alarm Alert  – Is a flashing display to indicate presence of an active alarm alert in the Alarms 
and Events panel. This visual alert function may be disabled, if desired.  

4.9 DEVICE MENU DISPLAY  

To display the configuration menu of a device listed in the device tree, double-click on the device name in 
the Devices View panel. Cattrax displays a menu tree of the device selected in the Menu Tree panel, and 
displays content of the first menu in the Main Display panel, as shown in Figure 4-8. 

A device menu may also be opened from the Alarms and Events panel by double-clicking the entry for any 
device reporting an alarm condition.  

 

 
A device must be active in order to be opened. 
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Figure 4-8  Display Of Device Opened In Device Menu Window 
 

Menus and sub-menus are contained in the Menu Tree panel for a selected device. Double clicking on the 
menu expands it to show menus and sub-menus under it. Single clicking on a menu heading in the tree 
displays device parameters associated with the selected menu, and current values and status obtained in real-
time from the device.  

Functions performed by icons located in the header area of the Menu Tree panel are specific to the selected 
device, refer to Figure 4-9. 

 

 
 

Figure 4-9  Menu Tree Header Content 
 

• Refresh – Allows retrieval of control parameters associated with a selected menu in the menu 
tree and updates the display  

 
• Cancel – Allows you to cancel retrieval of data for a currently selected menu. This could be 

used if Cattrax is experiencing problems communicating with the device  
 
• Help (?) – Displays information about a selected device. If the help icon is grayed out, it 

indicates that no information is currently available for that device 

Additional header entries may be displayed for specific controlled devices. These entries are discussed in 
the User Guide for the specific device.
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4.10 CONFIGURATION AND CONTROL  

When control pages appear in the main display panel, use the various controls, sliders, radio-buttons, etc. to 
change parameter values.  Figure 4-10 is an example screen showing various types of controls you may see 
on a typical Cattrax menu page.  

Tips:  

To achieve finer changes to parameter values when using a slider control, point the mouse to the slider 
on the slider bar, and then use the mouse scroll wheel. 

To reset individual controls right-click on the control and select Reset.   

 
Figure 4-10  Example Control Display Screen 

 

4.11 TILE DISPLAY OF MENUS 

To facilitate faster configuration of devices, Cattrax allows simultaneous display of up to four menus in tile 
mode as shown in Figure 4-11.  To display in tile mode, open up to four selected devices and select either 
Tile Horizontally or Tile Vertically from the View menu in the main menu bar.  If menus for more than four 
devices are already open, close tabs of devices not required for tiling then select the tile display mode. 
Maximize any tile, or open another device from the device tree, to return to tabbed display.  



Cattrax PC Based Control Application 
Publication 81-9059-0677-0, Rev. G 

March 2017 

 4-14 

 

 
Figure 4-11  Example Tile Display of Device Menus 

 

4.12 DISPLAY PANEL AUTO-HIDE  

Cattrax allows you to create a larger work space by using the auto-hide feature available on the Devices 
View, Device Properties, Menu Tree and Alarms & Events display panels.  With auto-hide active, the 
display panel is hidden and replaced by a tab attached to the side of the main display panel.  Moving the 
cursor over the tab returns the menu to the screen and removing the cursor causes the display to once again 
hide from view.  Clicking on the tab of a hidden display panel returns it to the screen and selects it as the 
active menu as indicated by the orange highlight in the header bar.  The screen remains visible until another 
display panel is selected as the active menu.  You may activate this feature for any desired display panel by 
clicking on the Auto-Hide Icon, as shown by Figure 4-12.  To disable auto-hide, restore display panel to the 
screen and click the auto-hide icon.    

 
Figure 4-12  Auto-Hide Icon Location 

 

4.13 ALARMS &  EVENTS MANAGEMENT  

All alarm and event (non-alarm) messages for devices in the managed system are displayed by the Alarms 
& Events panel as shown in Figure 4-13.  There are two main types of alarms – System alarms and Device 
alarms. System alarms are generated by Cattrax, while Device alarms are generated by the devices managed 
by Cattrax.  
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4.13.1 ALERTS 

When a major alarm is reported by any device in a managed system, Cattrax can display an alert in the form 
of a flashing red dot in the Devices View panel header area. This ensures that even if the Alarms and Events 
panel is closed, the user is notified of the occurrence of a major alarm.  Should Cattrax be minimized, the 
Cattrax entry in the Windows® operating system taskbar is highlighted to alert the user. The flashing alarm 
alert may be disabled, if desired.  

 

 
 

Figure 4-13  Cattrax Alarms and Events Panel Header Area 
 

4.13.2 REPORTED ALARM DETAILS  

Columns of the Alarms & Events panel display various properties of the messages: 

 
• Date & Time – Displays when message was first reported 

• Type – Identifies if notification is an alarm or an event, and the severity if it is an alarm.  

• Message – Provides a description of the alarm or event 

• Frame-Slot – Identifies device that initiated the message 

• Name/Alias – Displays the assigned device name or alias of initiating device 

• Duration – Displays elapsed time since the alarm was reported. This entry does not apply to 
event messages.  The duration display increments once each minute until the Fixed check-box in 
the Status column is checked.  

• Status – Contains check-boxes labeled Acknowledged (Acked) and Fixed, whereby the user 
indicates current status of the alarm condition.  This column does not apply to event messages.  
Entering a check in the Acked check box indicates the problem is acknowledged and is 
currently being worked.  Entering a check in the Fixed checkbox indicates that the problem is 
resolved.  Note that devices reporting major alarm conditions that have not been resolved are 
highlighted in red in the device tree.  
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4.13.3 SYSTEM ALARMS  

System Alarms refer to alarms and events generated by the Cattrax application, rather than those reported by 
a device. For example, a “Device Disconnected” message is displayed if for some reason Cattrax cannot 
access the network.  

To configure the severity of system alarms, click on the System Alarm Types button in the General 
Settings menu under the Settings tab.  You may configure each system alarm condition to report as a major 
or minor alarm; or you may select alarms to be reported as an event or turned off entirely.  

 

4.13.4 DEVICE ALARMS  

Device alarms are alarms and events reported by managed devices.    

 

4.13.5 ALARM FILTERING &  SORTING  

Filtering and Sorting helps users quickly find an entry in the alarm list.  For example, to find all alarms 
reported for a particular device, click on the column header for the Frame-Slot column to sort the alarm list 
by device IP Address; then scroll through the list to the frame IP of interest to find all alarms reported for 
that device.  Sorting is available for all columns in ascending or descending order. Click on the same 
column header to toggle between ascending and descending order. 

 

 

In order to view most recent reported errors, the alarm list must be 
sorted in Date-Time order. 

 

The alarms list may also be filtered by alarm type – Major, Minor, or Events by clicking on the Type 
column in the Alarms & Events panel area.  

 

4.13.6 BLOCKING ALARMS  

To prevent unnecessary messages being generated from a device, alarms for a particular device may be 
blocked by right-clicking on the device entry in the device tree and selecting the Block Alarms option. This 
option is useful when a device is being installed, configured or reconfigured for use.  
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4.14 M ENU BAR CONTROLS 

Controls located on the menu bar header, Figure 4-14, allow you to configure the application and set 
preferences. There are four items in the menu: Settings, View, Tools and Help.  

To display one of the submenus, single-click to open it temporarily, or double-click to keep the submenu 
display open.  The open display may be toggled by double-clicking on the menus.  

 

 
Figure 4-14  Cattrax Menu Bar 

4.14.1 SETTINGS MENU 

Functions available through the Settings menu, Figure 4-15, allow you to set internal configuration and 
other operational parameters of Cattrax.  
 

 

Figure 4-15  Cattrax Settings Menu 
 

• General Settings - Clicking the General Settings entry of the Settings menu opens the General 
Settings box, Figure 4-16.  The following functions are available through selections on the General 
Settings box: 

 
 

Figure 4-16  Cattrax General Settings Menu 
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- System Alarm Types – This dialog box contains three checkboxes that allow you to customize 
how alarm notifications are displayed.  

• Show alarms in red – Checking this box causes major alarm conditions to be displayed in red 
text in the Alarms & Events panel. 

• Show alarmed device in red – Checking this box causes the Devices View entry for a device 
issuing a major alarm condition to be displayed in red text. 

• Show blinking alarm indicator - The blinking alarm indicator is a red blinking icon that 
appears in the Devices View header when an alarm alert is activated.  

• Edit System Alarm Types – Clicking this button displays the System Alarm Types dialog box, 
as shown in Figure 4-17. To change current setting of an alarm type, select the box in the 
Type column and use the drop-down to select between available options.   

 

 
 

Figure 4-17  System Alarm Configuration 
 

- User Interface – This dialog box contains three checkboxes that allow you to customize how alarm 
notifications are displayed.  

• Allow duplicate sources on a panel page  – Checking this box allows duplicate sources on a 
control panel configuration page when creating or editing a PESA router configuration file. 
For further information, refer to the User Guide for the system controller device you are 
configuring. 

• Sort Sources & Destinations Numerically – By default router resource lists (sources, 
destinations, salvos, etc.) are displayed in ascending numerical order by the number 
assigned to the resource row entry, and displayed in the Number column. You may also sort 
list displays by double-clicking in the header of any of the name columns. If the Sort 
Sources & Destinations Numerically box is unchecked, the list is sorted alphabetically first, 
and any number in the name is sorted by the most significant (left most) digit (A1, A11, 
A12….A2, A21, A22, etc.) Checking this box will display the numbers in true numerical 
sequence and any alphabetic component of the name will be sorted alphabetically (A1, A2, 
A3….A11, A12…..A21, A22, etc.). For further information, refer to the User Guide for the 
system controller device you are configuring. 
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• Show Open Gear Oids – This checkbox is currently only applicable when using Cattrax to 
control a Cobalt multiviewer device – either an openGear compatible card or a stand-alone 
multiviewer device. When this box is checked, hovering the Cattrax page cursor over any 
multiviewer control command will open a display of the openGear Identifier (Oid) 
associated with the control function.   

- Operational Mode – The checkbox Load Devices from File determines whether or not Cattrax 
opens with a display of the device tabs from the previous session. The default option is checked, 
meaning that Cattrax will open each session with a display of the device tabs that were open 
when the previous session was closed. If the box is not checked, Cattrax will always open with 
no devices selected and no device tabs displayed.  

- System Log – Choices available through the Log level pull-down menu define how much 
information is presented by the log file.  The log file records the operation of Cattrax, to help 
debug problems. 

• Network Settings - Clicking Network Settings opens the Network Settings dialog box that allows you 
to view or modify network communication parameters for Cattrax.  In many installations, PESA 
devices may reside on subnets different from one another within the network. It is also possible that the 
host PC might contain multiple network interface devices, as would be the case, for example, if it 
contains both an Ethernet cable NIC and a wireless adapter.  Cattrax allows you to easily select both 
the network interface device it uses and the subnets on which it communicates through network 
preference settings.  Refer to Paragraph 4.2 of this User Guide for network configuration options and 
capabilities.  

4.14.2 VIEW MENU 

Control options contained in the View Menu, Figure 4-18, allow the user to configure Cattrax display. 

 

 
 

Figure 4-18  View Menu Controls 
 

• Show/Hide - Disable or enable corresponding display windows.  Console View is used only with a 
USB connected device; if no device is present on the USB port, this menu entry is inactive, as shown in 
Figure 4-18, and cannot be selected.   

 
• Window  - Is a group of controls to select window layouts as follows: 

 
- Tile Horizontally and Tile Vertically  - Control tiling of device menus within the display area  
 
- Default Layout - Restores layout of all display panels to default setting  
 
- Close All - Closes all the opened devices in the device menu display area  
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• WindowList  - Allows you to switch to a display of the next open device in the Device Menu display 

window.  
 
• Console – Opens the console window for a USB connected device.  Clicking this button performs the 

same action as selecting the Console View checkbox from the Show/Hide menu.   
 
• Appearance - Selects overall display style - blue is the default selection; options in this menu also 

allow changing the display orientation from right to left.  

4.14.3 TOOLS M ENU 

Control options contained in the Tools Menu are shown by Figure 4-19. 

 
 

Figure 4-19  Tools Menu Controls 

• Save System & Restore System - Allows you to save configuration data for the entire system and 
initiate restoration of a saved configuration to the system, refer to Paragraph 4-15. 

• Offline Configuration  – Allows you to create or modify configuration files for PESA system 
controller devices without Cattrax having to be attached to the device.  

• Update Firmware - Clicking Update Firmware allows you to download firmware and/or software 
code updates to flash memory of many PESA devices. Refer to Paragraph 4.17.  

• License Control – Opens menus for obtaining and installing license keys for certain PESA software 
applications such as Cattrax Web and PNet Soft Panels.  Specific licensing procedures are provided in 
the User Guide for the particular software app. 

4.14.4  HELP  

Control options contained in the Help Menu are shown by Figure 4-20. 

• Diagnostic Information - Initiates the Cattrax diagnostics file generation function.  Refer to Paragraph 
4.18 of this manual.   

• Cattrax Help – Opens an on-screen Cattrax User Guide 

• Release Notes – Opens the Release Notes for the Version of Cattrax Installed 

• About - Displays current version data of the Cattrax software 
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Figure 4-20  Help Menu Controls 

4.15 DEVICE AND SYSTEM CONFIGURATION M ANAGEMENT  

Functions available through Cattrax save and restore system features allow you to save configuration of 
managed devices, either individually or as an entire system, and use the saved configuration file to restore 
configuration data at a later time - if needed.  Save and restore functions may be accessed from either of two 
menus as shown in Figure 4-25.  The menu bar Save System icon under the Tools menu, as shown on the left 
in Figure 4-25, allows you to save entire system configuration.  You may use the right-click menu, as shown 
on the right in Figure 4-25, from the Devices View panel to save configuration of only the highlighted 
device or the entire system. 

 

Figure 4-21  Save and Restore Menu Options 
 

SAVING A CONFIGURATION FILE 
 
To save configuration data for a device, locate and highlight it in the device tree listing.  If you wish to save 
the configuration for a single device, highlight only that device from the tree listing.  To save configuration 
data for multiple devices, click on the device entries while pressing the control (CTRL) key.  Right-click to 
open the menu box and select the Save menu option as shown in the example screen on the right side of 
Figure 4-25.  The Save As dialog box, Figure 4-26, is displayed and prompts you to enter a filename for the 
saved configuration.  Cattrax will recommend a default filename and location for storing the file; however, 
you may enter any filename or directory location of your choice to easily locate and identify the file by its 
associated device or system.  Enter the desired filename and click on the Save button.  
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Figure 4-22  Save Configuration File Selection 
 
When you have entered the desired filename and location, the Save Configuration dialog box is displayed. 
An example box is shown by Figure 4-27, however the actual parameters displayed will vary by device. 
This dialog box allows you to select which configuration parameters of the device(s) you wish to save in the 
configuration file. You may uncheck parameters that are not required to be saved. Cattrax selects all 
parameters by default. Click the Save button on the dialog box to save the configuration file for the 
device(s).   

To save configuration data for an entire system, select any device in the device tree, and then select the Save 
System option from the right-click menu; or select the Save System icon under the Tools menu, as shown on 
the left in Figure 4-25. The remainder of the procedure is the same as save configuration for individual 
devices, explained above, except that the save list contains all devices in the system.  
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Figure 4-23  Save Configuration Dialog Box  
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RESTORING A CONFIGURATION FILE 

To restore configuration of a device from a saved configuration file, select the device on the device tree in 
the Devices View panel, right-click to open the menu box and select the Restore menu option.  The Open 
dialog box, Figure 4-28, is displayed and prompts you to select or enter the filename of the saved 
configuration file.  Enter or select the desired filename and click Open. 
 

 
Figure 4-24  Selection of Configuration File 

 

When a file is selected and the Open button is clicked, Cattrax automatically checks for hardware 
compatibility between the saved file and the device to be restored and displays the result in the Restore 
Configuration dialog box, Figure 4-29.  You may use the checkboxes to select or de-select any of the 
values you do not wish to be written into the restored configuration file.  If the Source and Destination are 
compatible, click Restore to reload configuration data to the device. Click Cancel to exit the restore 
procedure.  

To restore configuration data to an entire system, select any active device in the menu tree, right-click and 
select Restore System from the menu; or select the Restore System icon under the Tools menu, as shown on 
the left in Figure 4-25.  The remainder of the procedure is identical to the device restore operation except 
the restore list contains all system devices.  
 

 
 

Figure 4-25  Restore Configuration Dialog Box  
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4.16   BATCH CONFIGURATION  

The Batch Configuration feature of Cattrax allows you to simultaneously send commands and operational 
parameters entered or selected on any of the various interactive menu or control screens for a particular 
device type to multiple devices of the same type within the network.  To perform batch configuration, select 
multiple devices of the same type from the device tree by holding the CTRL  key down while clicking on 
device entries.  Then click on the Batch Configure button in the device tree panel header area, as shown in 
Figure 4-30.  The selected device menu will open in the menu tree panel.  Use the control and configuration 
menus to configure selected devices simultaneously.  Exit batch configuration mode by clicking any device 
entry in the Devices View listing or by clicking the batch configuration icon in the Devices View menu.  

 

Refresh
View

Batch
Configure

Locate
Device

Offline
Configuratio

n  
 

Figure 4-26  Batch Configuration Selection 
 

4.17 DEVICE SOFTWARE UPDATE CAPABILITY  

Many PESA devices that you will control through Cattrax contain board-resident software or device code, 
stored in flash memory, which from time-to-time may need to be updated.  Cattrax makes the entire 
firmware update process simple and straight-forward using the Update Firmware function available 
through the Tools menu.   

As new software updates for PESA products are released, they are available through PESA Customer 
Service or from the website at www.pesa.com. When you receive an update for a PESA device, the code is 
delivered to you as a single file with a filename descriptive of the update and ending with a .PBN extension; 
you must copy the file to the hard drive of the computer running Cattrax.  It makes no difference to the 
update operation where the file is stored, and you may use any directory structure you like.  For 
convenience, PESA recommends that you make a specific directory on your hard drive to store only .PBN 
files.  Whatever directory structure you use, you will have to access this directory as part of the firmware 
update process.   

The following procedure outlines the steps for updating firmware of PESA devices.  For this example, we 
have created a directory on the host PC named “SavedConfigs” to store the update files; and we will use a 
Vidblox device in the sample screens, but the procedure is the same for any device.  

 

1. Copy the .PBN update file to the desired directory on the host PC hard drive. 

2. Open the Tools menu on Cattrax and select the Update Firmware function as shown by Figure 4-
31. 
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Figure 4-27  Update Firmware Icon 
 

3. Selecting Update Firmware opens the Open Flash Update File dialog box as shown by Figure 4-
32. 

 

 

Figure 4-28  Flash Update Dialog Box 
 

4. Navigate to the hard drive directory containing the .PBN update file and select it from the listing.  
Ensure that the proper file is selected and that the correct filename is shown in the File Name: box 
and click Open to continue.  For this example we have selected the .PBN file that updates FPGA 
code in a Vidblox Receiver module to version 3.16. 

5. The Download Flash File dialog box, shown in Figure 4-33, opens with a display of all devices 
under control of Cattrax that use the selected .PBN file.  On the example screen, note that only 
Vidblox receiver modules on the network are displayed as candidates for installing the update file. 
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Figure 4-29  Download Flash Selection Box 
 

6. Each candidate device is identified by type, its alias name on the network and its IP address.  The 
Version column identifies, by individual module, the version of the code currently installed on that 
particular device; and the right-most column, labeled Select Action, displays the action the selected 
.PBN file would have on each device if downloaded, and allows you to select for each individual 
device whether or not you want to download and install the selected file.  For each device you will 
be prompted whether installing the update would take the device to an earlier code version 
(Backrev), re-install a new load of the current code version (Reload) or Upgrade the device to a 
newer code version (Upgrade). 

7. Place a check in the box beside the indicated action for the devices you wish to receive the file 
download and installation, or use the Selection Options radio buttons to select multiple devices as a 
batch.  Click the Download button to initiate software update or click the Exit  button to leave the 
screen with no changes.  

 

 

Downloading software code to most PESA devices will take the device off-
line for the duration of the download and will re-boot the device after 
installation. 

 

8. Download and installation is automated and a progress bar is displayed as the procedure is 
performed.  With many devices a re-boot of the device is required and is automatically initiated 
after installation of the new code.  
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4.18 CATTRAX DIAGNOSTICS TOOLS 

Cattrax provides built-in diagnostics capabilities that allow program folders containing system data to be 
combined into a single .ZIP file for easy communication with PESA Customer Service, should it ever be 
necessary.  This automated process makes it much easier for PESA technicians to acquire the data necessary 
for analysis to assist you if you have a problem with installation or operation of the Cattrax application. The 
following procedure outlines the steps for generating a diagnostics .ZIP file:   

 

1. Select the Diagnostic Information function from the Help menu as shown by Figure 4-34 to open 
the Save As dialog box, Figure 4-35. 

 

 

Figure 4-30  Diagnostic Information Menu Icon 
 

2. Enter or navigate to the directory where you want to store the diagnostics file.  Cattrax will insert a 
default filename for the .ZIP file; you may enter another filename if desired.  When the directory 
location and filename are entered, click the Save button to write the data file.  Click Cancel to abort 
the diagnostics operation. 

 

 

Figure 4-31  Diagnostics File Dialog Box 
. 
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Chapter 5 In the Event of Difficulty 
 

5.1 PESA CUSTOMER SERVICE  

If you have questions about, or are experiencing any difficulty with, your Cattrax software control 
application, contact PESA’s Customer Service Department.   

By E-Mail – service@pesa.com 

By Phone – 256-726-9222 (24/7) 

Technicians are available to assist you 24 hours a day, seven days a week. 

 

5.2 PERIODIC M AINTENANCE  

No periodic maintenance is required. 

 



 

 

 

 


